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FLIGHT SIM TOOLKIT 

The license conditions printed below govern your use of the 
software. 

End User License Conditions. 

i) You may copy Flight Sim Toolkit for installation onto your hard 
disk or for backup purposes only. 

ii) Simulations created using Flight Sim Toolkit may be sold or 
distributed freely as long as Flight Sim Toolkit is clearly credited as 
the means by which said simulations were designed. 

iii) You may not disassemble, reverse engineer, decompile or 
make any attempt to discover the source code of the software. 

Technical Support 

Technical Support will be provided if a query is sent in writing to: 

Flight Sim Toolkit 
Simis Ltd 

26 Chitty's Walk 
Keens Park 
Guildford 
Surrey 

GU33HW 

Queries may be in the form of a letter or may be faxed on: 

0483 235275 

Alternatively send a disc with a readme file and an example. 
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Pre-Flight Briefing 

Before you get started a few words on how to use the manual. 

We recommend that you spend time to read the Introduction a_nd 
following chapters on Creating a Simulation, Creating Shapes, 
Creating a World, Combat, Hangers, Depots and routes, which are 
found later in Section 1 , to acquaint yourself with the general 
principles of flight simulation creation. This will make life a lot 
easier in the long run. 

Once you do get started you will find the user interface to the tools 
intuitive and that you need only refer to the manual when 
something is not clear. We do however suggest that you read the 
start-up and basics paragraphs in the tools chapters to gain a 
head start. 

Installation 

Rise OS 

This manual assumes you are familiar with the Rise OS operating 
system. If you are new to the Archimedes the Welcome Guide 
explains how to find your way round the desktop. ' 

Backup 

Flight Sim Toolkit is not copy protected and we strongly 
recommend that you make a backup of the master discs before 
you go any further. 
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The Discs 

Flight Sim Toolkit comes on two discs which contain the following; 

Tools; 

Examples; 

Contains the !Shape, !World, !Model, !Cockpit, 
!View tools; !System and !Sysmerge and also the 
base simulation !Flight. 

Contains two example games, a directory of 
shapes. 

Single floppy machines 

When you are ready to start, load the Tools disc into the drive and 
click on the floppy disc icon on the icon bar. A window will appear 
showing the files on that disc. 

Now follow the instructions for starting a tool as detailed at the 
start of the appropriate tool's chapter in Section 2. 

Saving your work is simple and described in the tool's Save 
paragraph. 

Hard disc machines 

If you use a hard disc, it is recommended that you create a new 
dir.ectory called 'FST' and then copy both of the floppy discs into it. 

You will then have to carry out a SysMerge as follows: 

First you should select one !System to be be your master !System. 
If you are a new user of RISC OS computers, this should be the 
!System supplied on the First Applications Disc. All modifications 
should be made to this !System or a copy of it. If necessary copy 
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this master !System to a disc with plenty of free space. You might 
want to copy it to a newly formatted disc which can become your 
master system disc. (If so, your should give the disc a 
recognisable name, for example SYSTEM, using Name disc from 
the disc icon menu). Copy !SysMerge to the same disc as the 
master !System so it is readily available. You are now ready to 
start building your master !System. 

Startup the !SysMerge application by double clicking on it. A 
dialogue box like this will appear 

~I &31 !Systeft Merqe Utility 
Master !Systeft: I 

New ! Systeft: I 

Drag the original !Syste"' into 
this window. 

I 

I 

<<Upper box 

<<Lower box 

<<Messages 

Drag the master !System directory to anywhere in the !SysMerge 
dialogue box. The upper box (for the Master !System) should 
change to path name containing your master !System. You should 

' now drag a !System which you wish to add or consolidate into your 
master !System. The pathname for this will appear in the lower 
box. (If you use a purely floppy based system you may have to 
change discs during this process. If there are no problems the 
!Systems will be consolidated and the message "!System 
Updated" will appear. If there are problems, you should read the 
error messages and take appropriate actions. The only common 
error message you may see is "disc full" which should not occur if 
you are consoliding onto a new system disc. If you have additional 
files on the master !system disc you should move them elsewhere. 

7 



FLIGHT SIM TOOLKIT 

If an error occurs !SysMerge will report "Update failed. Correct 
problem then drag the ... ". Once you have resolved the problem 
you can restart the merge process. 

When !SysMerge is finished you can quit the application either by 
menuing on the !SysMerge window and selecting QUIT or by 
selecting the CLOSE () icon on the window. 

You should repeat the above process on all the !Systems on all 
your discs until you have the one master !System. This can then 
be used for all your work. Its probably worthwhile making a copy of 
it once it is produced and putting that copy away somewhere safe. 

Remember when you modify your master !System in future, you 
should take a new copy of it. Do not delete older !Systems just in 
case something has gone wrong. 
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Introduction 

The Flight Sim Toolkit is a set of tools that allow you to create a 
complete flight simulation. You can either start from scratch and 
define every detail or you can modify one of the examples 
provided. 

There are many important elements to consider within a complete 
simulation. Starting from a working example allows you to add 
your own features one by one and test the result immediately. 

The two main tools are the Shape Editor and the World Editor. 
You first use the Shape Editor to create new shapes for aircraft, 
runways, buildings, bridges, roads. rivers or anything else you 
want in the world. Alternatively you can choose existing shapes 
and modify them later. 

You then use the World Editor to place the shapes in the world. 
You can give shapes properties. It is always a good idea to give 
runways the land-on property or you will not even be able to taxi 
around your airfield. You can even define a shape to be an enemy 
hanger, which will produce enemy aircraft when you fly too close. 

If you want to design your own cockpit layout you use the Cockitit 
Editor to position dials and readouts within the background of a 
sprite. You can use !Paint or any sprite editor to create a cockpit 
background. 

You can change the performance of your own or enemy aircraft 
using the aircraft Model Editor. You can vary performance from a 
Cessna 152, to a Pitts Special, using propeller power, or from a 
Hawk trainer up to a Tornado with a jet engine. You can even 
create unlikely or impossible types of aircraft. 
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S ctlon 1 contains a description of the elements of an FST flight 
simulation, and the concepts behind the design of FST. Section 2 
describes in detail the RiscOS tools required to create the various 
elements of the simulation. Section 3 concerns itself with the 
actual flight simulation itself. There is an obvious corespondance 
between chapters is section 1 and 2; the chapter in section 1 
describing philosophy and design and the chapter in section 2 
describing the associated RiscOS tool. 

Section 1 

Creating a Simulation <> 
Creating Shapes <> 
Creating a World <> 
Designing Aircraft <> 

10 

Section 2 

Project structure and datatypes 
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Section 1 

Creating a simulation. 

A simulation consists of the general simulation framework program 
and the data files that describe a particular simulation. 

The simplest way to start is by making a copy of the !Flight 
application, which is supplied on the Tools disc. This is a directory 
which has been set up as a RiscOS application and contains a 
complete set of data files and the simulation framework. Double 
clicking on !Flight runs the program which starts up with a jet 
sitting on a simple runway in an empty world. The jet has a 
general aircraft shape and average performance. The cockpit is 
just a flat grey panel with some dials. You can take off, fly round 
and land but the view is very dull. This is however a good starting 
point and anything you do will be an improvement. 

!Flight is a directory which is treated as an application by RiscOS 
because it's name starts with an exclamation mark. You can open 
it as a directory by holding down a SHIFT key while double clicking 
on the !Flight icon. If you don't want a RiscOS application just 
create a normal directory and copy all the files from !Flight into it 
You don't need the !Boot or the !Sprites files in a standard 
directory. You can then run the simulator by double clicking on the 
!Run file in the new directory. 

You will need to open the directory to modify the data files which 
control the simulation. The type of a data file is shown by its icon, 
provided a directory containing the appropriate editing application 
has already been opened. You can modify a data file by double 
clicking on it's icon or by dragging it to an already running e'ditor. 
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!Flight 

adfs::Tools.$.!Flight 

~ • !Boot !Run !Sprites data 

~ ~ • fly FSTerr shapes Sounds 

~ 
world 
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cockpit Model panel 
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Aircraft runway 
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'Fly' is the program that runs the simulator. It is started by the 
!Run obey file. Once started it reads the data files in the simulation 
directory to let you fly in the world you have designed. All the data 
fires must be present for the simulation to work. 

'Shapes' is a directory that contains all the shape definition files for 
a particular simulation. Shape files can be created and modified by 
the shape editor. The shape designer is the application !Shape 
supplied on the Tools disc. 
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'World' is a file that describes the position and properties of all 
shapes in the simulated environment. 'World' can be modified by 
the application !World supplied on the tools disc. Before any shape 
can be added to the world it's definition file must already exist in 
the Shapes directory. You may want to start with simple shape 
definitions to add to 'World', and then create the final shapes later. 
For example all buildings can start as copies of a box shape and 
then be made more realistic when you are ready. The names of 
shapes used in 'World' are the filenames of the shape files in the 
Shapes directory. 

The data directory contains the remaining files required by the 
simulation. These are the cockpit data file (cockpit), the cockpit 
sprite (panel) and aircraft model files (in this case just one -
model). 

Sounds contains sound samples. (It is optional) 

FSTerr is created by the simulation if any error occurs during 
execution. 

You can change the features of the basic simulator in any order. 
You can include items from the examples by replacing any of the 
files in the directory with the equivalent file from an example. In 
particular you may want to copy shape definitions from the Shap~s 
directory in an example to the Shapes directory in your new 
simulation. 

You may want to improve the appearance of the cockpit, either ·by 
referring to a photograph of a real cockpit or by designing your 
own. Use a sprite editor (!Paint for example) for the background 
and then position and scale the instruments on the sprite using the 
cockpit designer. The cockpit sprite is in the sprite file 'Panel' and 
the instrument layout is in the file 'Cockpit'. The cockpit designer is 
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the application !Cockpit supplied on the tools disc. 

To change the performance of an aircraft you use the aircraft 
designer, !Model. Choose between propeller and jet power and 
setup the aerodynamic properties of the aircraft. 

Creating shapes. 

You use the application !Shape to create and modify shapes. The 
Shapes directory contains all the shape files for a simulation. 

You can run the shape editor by either double clicking on the 
!Shape application or double clicking on a shape file. Each time 
you douple click on a shape file you run a new copy of the shape 
editor, you may find this useful for comparing shapes, but you may 
not have enough memory to run multiple shape editors. It is more 
usual to drag a shape file onto an open shape editor window, or 
the shape editor icon on the icon bar. 

A shape is 3 dimensional structure composed of flat coloured 
surfaces called polygons. A polygon has a number of points, each 
point is at a corner or vertex. For example a box has 8 points and 
6 polygons. Each polygon in the box has 4 vertices. 

Before you can define any polygons you have to position the 
points that will be polygon vertices. A shape has a centre called 
the· origin. A point is defined by distance from the origin in each of 
3 directions. These directions are called the X, Y and Z axes. The 
Z axis is defined as towards the front of a shape. If you imagine 
yourself facing forwards along the Z axis then the X axis is from 
left to right and the Y axis is from below to above. You can position 
points with either positive or negative distances along any axis. A 
distance along an axis is called a coordinate. 
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Distances are measured in metres and kilometres, accurate to the 
nearest 1 /8 metre. This is convenient for the size of objects 
normally seen in flight simulators. There is a limit of plus or minus 
2000 metres for any coordinate in a shape. If you want to create a 
shape bigger than 4000 metres across then it must be composed 
of several shapes that are within the limit. 

y 

N 

z 

w "'---------- x E 

s 
The simulated world has North in the positive Z direction, South in 
negative Z, East in positive X, West in negative X, up in positive Y 
and down in negative Y. 

The ground is defined as being at position 0 on the Y axis. You 
can't fly underground which would give you a negative ' y 
coordinate. Any shape which will be on the ground should only 
have positive Y coordinates or parts of it would be underground. 
For example a simple box shaped building would have 4 points 
with a Y coordinate of O and 4 higher points with a Y coordinate at 
the height of the roof. 

The shape editor works with flat planes on which you place points. 
The easiest way to visualise this is as a stack of graph paper. You 
can choose which individual piece of paper you draw on at any 
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tim . The planes can be in any of 3 orientations. The shape editor 
uses planes cutting across the X, Y and Z axes. Most buildings 
and other artificial structures have sides which are in one of these 
planes and can be constructed using just one plane. The Y plane 
is the obvious choice as it is easy to visualise a building being 
constructed from the ground up. You can define polygons in any 
other orientation by moving the editor plane while connecting 
points. 

You can edit shapes of very different sizes with the shape editor. 
When you first open a shape editor window it shows a view 4000 
Metres across. This is the largest shape you can create. For 
smaller shapes you should zoom in until your shape fills the 
window. Use the grid lines to show you how large the shape is. 

A polygon must be flat or it will seem distorted when you view it 
from some directions. This means that all the points in a polygon 
must lie in the same plane. For complex shapes you should 
remember that a triangle is always flat, so it is often easier to use 
polygons with 3 points. 

A polygon has 2 sides, when part of a shape it has an inside and 
an outside. Usually you only want to see the outside of shapes so 
you have to define which side of each polygon is the outside. You 
do this when you create a polygon by joining up points. The front 
of the polygon is the side created by joining the points in a 
clockwise direction. If you get this wrong the shape editor allows 
you'to flip the orientation of any polygon. A polygon will only be 
drawn in the simulation if its points are linked in a clockwise 
direction. 
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For example in the above diagram is a cube which consists of 8 
points and 6 polygons. The shaded polygon is created by using 
Polygon enter on points 1, 7, 6, & 2 in that order (clockwise) so 
that the new polygon can be seen when viewing the cube from the 
outside. In this example the shaded polygon is in the top level of 
the Y axis. During the editing of a shape you can examine the 
points in all axis by using wireframe. 

You can check the appearance of a shape by viewing it. This is 
the 'View' menu option in the shape editor and shows the shaP.e 
as it will appear in the simulation. You can rotate it to check that it 
looks OK from all angles. Any polygons defined inside out will be 
obvious and you can flip them over. 

If you want to see both sides of a surface you have to define a 
polygon for each side. 

You can create lines as polygons with 2 points. 
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Frame speed is important in a flight simulator. Speed is measured 
by the number of screen updates per second. Anything less than 
about 1 O will appear jerky and make controlling the aircraft more 
difficult. Your simulation will run fast when it is drawing as few 
polygons as possible. This means that shapes that are far away 
should be drawn with fewer polygons than when they are close. 
An example of this is an aircraft shape. When close it may have 
more than 50 polygons, when in the middle distance it may have 
fewer than 10, and in the far distance 5 lines is usually enough. 

The shape editor expects each shape file to have three shape 
definitions. The first for near, the second for middle distance, and 
the third for far. You can choose the distances at which shapes 
change. If the change happens too near you will see the low detail 
shape. The distances depend on the size of the shape and your 
preference for good detail versus speed. The shape View option 
allows you to move away from the shape and check that the 
change is visually acceptable. 

When you create roads and rivers you should use lines until you 
get quite close. You will usually be flying quite low and a line in the 
middle distance looks better than a polygon seen edge on. Look at 
the rivers and roads in an example to see how this works. 
You have to define three shapes for each object in the world. The 
editor allows you to copy shape definitions between levels. You 
will probably find it easiest to define the near shape first and then 
copy it to the middle level. You can then delete some polygons 
and points to define the middle distance shape as the same size 
as the near shape. The middle shape can then be copied to the far 
shape and more polygons and points deleted. 

You should use the Shape editor to look at some of the example 
shapes to see how the system works. 
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For a detailed description of the shape editor refer to the !Shape 
reference chapter. 

Creating a world. 

The World file contains all the information about the positions and 
properties of shapes. It can be modified by double clicking on it or 
dragging it onto the !World application window or icon bar icon. 

Your simulated world is limited in size to a square 100 Kms on a 
side. When you first open the world editor window you will see the 
whole area. You can select any object in the world and zoom in 
see its position in more detail. Use the grid lines to show you how 
large the current window is. 

You have to choose the colour of the ground. For a land based 
simulation this should be a dull green or brown. You can choose 
any colour from the standard 256 colour palette. You then add 
shapes to this base to make the world more interesting. Rivers, 
roads, fields, towns and hills are all possible. 

If you want a sea based simulation then make the ground a sea 
blue. You will have to create islands as shapes on the sea. The 

' limit of 4000 metres for the size of a shape means that islands will 
have to be synthesised from smaller shapes. You will have to stick 
to small islands unless you want your simulation to run slowly. You 
will have to experiment with different setups to discover what 
works. The example !Tornado is a sea based simulation. 

You will always need a runway to start from. You should make a 
runway at least 1 Km long and 100 metres wide. If it is much 
smaller then you may be unable to takeoff before getting to the 
end, and landing will be very difficult. You should give runways the 
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land-on property, and choose one to be your start point. If you 
don't have at least one runway with start-point and land-on 
properties then the simulation framework will stop and complain. 
You can give any other flat shape the land-on property, so you can 
land on roads if you want. It is even possible to create an aircraft 
carrier by giving a suitable shape the land-on property. You will 
need to make it quite large if you want to stop on it after landing. 

You will probably find that creating roads and rivers is the most 
difficult part of the world. The main problem is getting shapes to • 
join up accurately. The easiest way to to this is to design the 
separate bits to fit onto the grid. For example you may want all 
road bits to be 1 Km long with the centre 500 metres from each 
end. You can then set the grid in the world editor to be 100 
metres, enable the snap to grid option, and position the road bits 
exactly 1000 metres apart. This will guarantee that they join up. 

You will probably not want a different shape for each bit of every 
road and river. It is easier to design some useful components and 
reuse them. For example a road running East to West only needs 
one shape, which you can reuse as often as you want. Rivers are 
more complex, but you will probably find it easiest to design a 
basic unit from several shapes and then repeat this unit. The 
examples show this technique in action. 

You will find it quite simple to design a world, but it takes some 
practice to make it look good when you are flying around it. You 
stiould aim to put in enough objects so that something is always in 
view, but not so much that the simulation runs so slowly that flying 
is difficult. 
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Navigation 

If you want to navigate in the world you can include radio beacons. 
These are VOR stations, and should look like radio masts, 
although you can disguise them as anything you like. You should 
also design your cockpit with a VOR instrument if you want to see 
the bearing to one of the VOR stations. You can make any object 
into a VOR station by giving it the VOR property and an 
identification code. 

Combat 

When you have created a world, you may want to turn it into a 
combat simulator. You do this by adding enemy objects. You can 
make any object into an enemy by giving it an enemy class. 

AA Gun 

AA Guns are ground based point defences. They are fairly 
accurate and difficult to hit without being shot down. They use a 
simple predictor system to aim with. Either cannon or rockets will 
destroy AA Guns 

SAM ' 
SAMs are radar guided. The launchers appear as red points on 
the radar when active. Cannon, Rockets or A-G missiles can be 
used to destroy them. 

Hangers 

Hangers produce enemy aircraft. Enemy aircraft appear 50 metres 
North of the centre of a hanger facing North, taxi 100 metres 
straight ahead and then turn 90 degrees left and take off due 
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West. If the hanger is too big along the positive Z axis then the 
aircraft will appear inside it. If you want this to happen make sure 
the North end of the hanger is open or the aircraft will crash into 
the wall and blow up before getting airborne. If you rotate the 
hanger object then the enemy aircraft will also be rotated, so you 
can make them take off in any direction. It looks better if there is a 
runway 150 metres from a hanger so that the aircraft appear to be 
using it, but they will takeoff even if there isn't one. A hanger will 
only produce enemy aircraft when you are within a certain 
distance of it. 

Each hanger can only produce a limited number of aircraft. You 
can choose this number. If you attack a hanger and destroy it then 
all the aircraft inside it are also destroyed. Hangers can be rebuilt 
by enemy trucks. If a truck arrives at a hanger then it will be rebuilt 
and each subsequent truck will supply one more aircraft. 
The shape and performance of enemy aircraft is setup by dragging 
an aircraft model file onto the hanger setup dialog box. This allows 
you to use the aircraft designer to control the speed and handling 
characteristics of enemy aircraft. 

Depots 

Trucks are produced by depots. You can make any object into a 
depot, and its trucks can also be any object. You have to b 
careful about the size and shape of both depots and trucks if you 
don't want trucks crashing into depots. Trucks appear at the first 
point in a route, so this should be placed close to a depot; th 
truck then follows the route. Make sure neither the depot nor other 
objects are on the truck's route. A depot produces a limited 
number of trucks, which you can choose. If you destroy a depot all 
its remaining trucks are also destroyed. A depot is rebuilt when 
truck reaches it from another depot. Each subsequent truck i 
added to its inventory and can be sent out again later. 
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A depot only despatches trucks when one of the objects at the end 
of one of it's routes needs supplying. 

You can use your imagination with the shapes of depots and 
trucks. An interesting choice would be a dock as a depot and a 
ship as a truck. The background colour should be blue, and the 
depot should be on the edge of an island for the simulation to look 
sensible. 

Routes 

A route is a sequence of points in the world, linking one object to 
another. The start of a route has to be a depot. The end point 
should be an object with an enemy class. The depot at the start 
will despatch trucks along the route at regular intervals, which you 
can choose. When the truck arrives at the end of it's route it will 
supply the object there. If this is not an enemy object nothing will 
happen. If it is a destroyed enemy object then it will be rebuilt. If it 
is a hanger an enemy aircraft will be added to it. If it is a depot the 
truck will go in. If it is an anti-aircraft gun then it will be re-supplied 
with shells. If it is a SAM site then it will get mare missiles. 

• 
Designing Aircraft 

You can control the performance and handling characteristics of 
your own and enemy aircraft using the !Model application. You 
should create the visible shape of the aircraft using the shape 
editor. There is no relationship between the visible shape and the 
performance of the aircraft, it is up to you to design an aircraft that 
performs as it's shape would suggest. You choose which visible 
shape and which aircraft performance model to use by dragging 
appropriate files onto the player or hanger attribute controllers in 
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the World editor. 

You will need to experiment with the aircraft designer to get a feel 
for the effects of design changes on aircraft performance. Some 
designs will not fly, and it is up to you to choose a sensible 
numbers. For instance if you design an aircraff weighing 20000 lbs 
with an engine power of 200 lbs it will not take off. 

You can only design small aircraft. These can range from small 
biplanes like a Pitts Special up to a Phantom jet. You can choose 
the aircraft to be propellor or jet powered, but the thrust is always 
considered to come from a single central engine. You can deal 
with multiple engines as a single more powerful engine, however 
they are always considered to act together, so you can not have a 
failure of just one engine. 

The main window of the Model application shows a plan view of 
the aircraft at the top and a back view at the bottom. The absolute 
size of the aircraft is not very important, the idea is to allow you to 
design the relative sizes and shapes of the wing and tailplane. 
These sizes affect the performance and handling of the aircraft. 
If you design the planform to look like a real aircraft the 
performance should be similar to the real thing. However if you 
want to design your own aircraft you will have to understand some 
aerodynamics. 

The most important feature is the shape of the main wing. The 
disfance of the wing tip from the fuselage is called the wing span, 
arid the average distance from the front of the wing to the back of 
the wing is called the wing chord. The aspect ratio is the wing 
span divided by the wing chord. A very efficient aircraft like a 
powered glider has a high aspect ratio, which means it has long, 
narrow wings and flies well at low speed. The disadvantage of this 
design is that there is a lot of drag and the aircraft will not fly fast 
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without a lot of power. Fast jets usually have a low aspect ratio 
which gives poor low speed performance but is good for high 
speed. 

The weight of the aircraft is important. An aircraft with a low aspect 
ratio and low weight will fly slowly, but not as well as an aircraft of 
the same weight but with a higher aspect ratio. 

The total area of the main wing is also important. A small area will 
give a high stall speed, while a large area will give a low stall 
speed but more drag. Biplanes have a large wing area and fly 
slowly because they have a lot of drag. You can design a biplane 
by giving the wing the correct span but making the wing chord the 
sum of the chords of each wing. This looks odd but is a simple 
way to represent the total wing area. 

The position of the wing relative to the centre of the aircraft is not 
very important, as the centre of lift of the wing is always assumed 
to be just behind the centre of gravity of the aircraft. This makes 
the aircraft stable. 

The position and size of the tailplane effects the pitch handling. 
The further back the tailplane the more pitch stability. The larger 
the tailplane the more elevator control and pitch stability. The slze 
of the tailplane also affects the total drag. A very large tailpane will 
produce too much elevator control, excessive pitch stability and 
lots of drag. 

The back view at the bottom of the main window allows you to 
change the size of the fin and the wing dihedral. A larger fin gives 
more rudder control and more yaw stability, but also more drag. 
The wing dihedral is the angle of the wings from horizontal. As 
you move the wing tips up the aircraft becomes more stable in roll. 
This means that it tends to roll Jevel with no aileron control input. 
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Aerobatic aircraft have very little dihedral and require pilot control 
to fly level, while trainers have high dihehdral and tend to be stable 
in roll. You can give negative dihedral, which means that wings 
droop down towards the tips, and the aircraft will tend to roll 
upside down. 

The data control box allows you to set other performance 
characteristics. 

The wing incidence is the angle of the wing from horizontal on the 
fuselage. It allows the wing to be at an angle to the airflow, and 
therefore produce lift, while the fuselage is level. The best wing 
incidence gives level flight at cruising speed. Fast jets have a low 
incidence of about 1 or 2 degrees and slow aircraft have an 
incidence of about 5 to 10 degrees. If you find the aircraft is 
climbing at cruise speed with the nose pointing at the horizon then 
the incidence is probably too high. 

The stall angle is the angle of attack at which the wing stalls. The 
angle of attack is the angle at which the airflow hits the wing. A 
wing produces more lift as it's angle of attack increases, but only 
up to the stall angle. After the stall angle the lift decreases and the 
drag increases. The aircraft can stall at any speed. High speed 
stalling can be induced by too much up elevator control, which can 
increase the angle of attack to beyond the stall angle. Simp~e 
wings stall at about 15 degrees, but leading edge slats, flaps and 
other devices increase the stall angle. Few conventional , aircraft 
can have a stall angle greater than about 20 degrees. Some 
modern jet fighters use advanced aerodynamics and the stall 
angle can be up to 30 degrees. 

The aircraft power should be related to weight. Power should 
usually be less than weight, although a few modern jets have a 
power to weight ratio of greater than one. A typical light propeller 
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aircraft has a power to weight ratio of about 1 /4. The weight of 
aircraft should be realistic. A light aircraft weighs about 1000 lbs 
and a fast jet may weight about 20000 lbs. 

The drag value depends on how streamlined the aircraft is. A low 
value will give a higher top speed. You should adjust the drag 
value to give your aircraft a realistic top speed. 

The ordinance control box allows you to set up any armaments the 
aircraft should have. Leaving all values as zero will give an aircraft • 
with no weapons. 

A typical cannon has about 250 rounds. A typical load of rockets is 
36. Air to air missiles are heat seeking and perform like a 
sidewinder. Air to ground missiles are optically guided and perform 
like a TV guided maverick. 
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Section 2 

Project Structure & Filetypes 

Editors 

!Shape 
!World 
!Cockpit 
!Model 
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Project Structure and Filetypes 

Creating a Simulation in section 1 described the structure and 
contents of the !Flight simulation provided on the tools disk. This 
chapter describes concisely which elements of !Flight you need to 
create your own simulation and which files are optional. 

~ ~ llf] 
!Boot !Run !Sprites data 

~ ~ 
fly FSTerr shapes Sounds 

~ 
world 

The following are the basic files required to run a simulation, the 
data and shapes folder may empty but must exist. 

!Run - application run file, sets up environment variable FST$dir 
used by fly to tell it where to find the world database file and its 
associated data and shape files. 

fly - the flight sim. code. 

qata folder - contains FST model , FST cockpit files and cockpit 
sprite file. For a standalone application this folder MUST contain 
the FPEmulator 'Floating Point Emulator'. 

shapes folder - contains FST shape files. 
world - the FST world database, this file must be present and must 
be called world. 
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The following are only required if you wish you flight sim. to be a 
RiscOS application. 

!Boot - application boot file, registers application !Sprites file with 
RiscOS filer · 
!Sprites - contains application filer sprite 

The following are optional (or generated by the sim. itself) 

FSTerr - generated when running application if an error occurs 
Sounds - contains sound samples loaded by simulation 

Filetypes (and their editors) 

The Flight Sim Toolkit has two allocated filetypes 

lf:_ - Shape (&c3c) 

FSTj - FST (&c3b) 

The shape filetype contains only 30 point and polygon definitions 
of objects. Double clicking on a Shape file will run the !Sh<ipe 
application and load that file. 

The FST filetype contains the world database, aircraft model and 
cockpit datastructures. You cannot tell from the filer icon which 
datastructure is contained, however double clicking on the file runs 
a despatcher program which automatically runs the required tool 
(!World, !Model or !Cockpit). Because FST file contents are 
indestinguishable from the desktop it is recomeneded that you use 
descriptive names for model and cockpit files (which are both 
contained in the data folder), e.g. har_model and har_cpt. 
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!Shape L:::. 

Shape is an editor, it allows you to create and edit 3D shapes. 

Shape is controlled from a menu tree (for a description of menus 
see the Acorn User Guide Part1) and a set of windows. 

Starting Shape 

Shape is started the same way as other editors: by first installing 
its icon on the icon bar and then clicking on that icon. For more 
details see Acorn's User Guide; 'Documents and their editors'. 

Icon bar menu: 

Shape About this prografll 
llitlil¢ Naflle: Shape I Quit Purpose: 3D Shape Editor I 

Author: © Sifllis Ltd, 1991 I 
Uersion: 1.88 I 

Info tells you about !Shape 

au.it removes the Shape application from the icon bar. If unsaved 
dc;ita exists in the shape a warning box is displayed asking you to 
Save, Discard or Cancel. 

The Shape Window 

To open the shape window click on the icon bar Shape icon with 
the left button. 
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Basics 

A shape is constructed from three levels, each level defines what 
the shape looks like at a particular level of detail. Each level is 
constructed of points and polygons. The Shape editor allows you 
to enter and adjust points and link them into polygons. 
For more details of the structure of shapes see Section 1 . 

You use Shape in operating modes 

Enter point 
Delete point 
Enter polygon 
Select polygon 
Select group 

Modes are chosen from the menu or toolbox. 

Shape window menu: 

ShaPe 
Misc 
Save 

Edit 
Shape 

~' 
~) 

~) 

? 
Wirefra"'e ? 
Grid ~~ 

Uiew 
.J Toolbox 
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Shape I Misc 
Lliillllllll¢. Clear 

Sha e 
Misc ~> Save as: 

Clear deletes everything from the 
database. 

i--------1 

The Save menu allows you 
to save the shape. The 
save procedure is 
described in full in the 
Loading and Saving 
chapter of the Acorn User 
Guide. In order to save a 
file in the easiest way, you 
need to have on the 
screen the directory 
display for the directory 
where you want to save 
the file. Move to Save, 

Save ? 

Edit ~ I untitled I[@ Shape 
Wiref ra"'e ? 
Grid ? 
Uiew 

.J Toolbox 
and a box appears containing ; an icon, the current filename and 
an OK box. If the file has not been saved before, Shape offers you 
a default filename of 'untitled'. If you want a different name then 
delete Shape and type in the name you want. Place the pointer on 
the icon in the menu and drag the icon into the destination 
directory display. 
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Entering and Adjusting Points 

Open the Toolbox by clicking on the Toolbox item in the Shape 
Window menu. 

Select Enter Point mode from the toolbox by clicking on the icon in 
the toolbox window. When in Enter point mode the cursor will 
appear as a pair of crosshairs in the Shape window. 

To enter a point in the current plane click on the Shape window at 
the desired position with the left button, a cross will appear 
representing the point that you have entered. 

To move a point already entered, drag it with the adjust (right 
mouse) button. 

in Select point mode: 

Shape 
Misc ¢ 

Save ¢ Point 
~'llHll? Delete 
,.. ..I! 1. Jo. 

The currently selected point is 
shown as a box (all other points 
are shown as crosses). To select 
a point click on it when in Select 
point mode. To delete the 
selected point choose the 

Shape=>Selected=>Delete item from the shape window menu. 
The point will be deleted only if it is not contained in any polygon. 
Any points not contained in a polygon in a finished shape should 
be deleted because they play no part in the rendering of the shape 
in 30 and only slow the processor down. 

Keyboard shortcut for Shape=>Selected=>Delete Ctrl X 
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Entering and Adjusting Polygons 

Select Enter polygon from the toolbox. The mouse will change to a 
3 sided polygon when in the shape window. 

Click on each of the points to be contained in the polygon (in 
clockwise order), using the up/down icons (or cursor keys) to 
move between planes. When you reach the last point in the 
polygon click on it with the right button, this tells the Shape editor 
to end the polygon and sets the editor mode to Select Polygon. 
The new polygon that you have created will become the selected 
polygon. This polygon will be the same colour as the last polygon 
created or selected. Polygons must have at least two points. 

To abort polygon entry click on the toolbox Enter polygon icon with 
the right mouse button. 

When you have entered a polygon it will become the currently 
selected polygon. You can also select any polygon by entering 
Select polygon mode by clicking on the toolbox icon and then 
clicking on a point in the required polygon in the shape window. 
Where there is more that one polygon attached to a point clicking 
repeatedly on that point will select each polygon in turn. 
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Sha e 
¢ Misc 

Save ¢1--"""'P_o..,...l -on--. 

''1411QI¢ Delete "X 
Edit ¢ Colour "C 
Shape ¢ Flip "F 

1---.:....-----' 
Wirefra"'e ¢ 

Grid ¢ 
Uiew 

./Toolbox 

Delete deletes the seleted 
polygon. 
The keyboard shortcut 
forShape=>Selected=>Delete 
is Ctrl X 

Colour opens the colour 
picker, this window remains 
open until you close it. The 
colour of the currently selected 
polygon will be highlighted in 
the picker and may be changed 
by clicking on a different colour. 

If no polygon is selected then the creation colour for the next new 
polygon is set. The colour picker shows 256 colours, in 16 colour 
modes it shows the best approximation to the real colours using 
the current desktop palette. (In 4 and 2 colour modes it shows no 
useful information). 

The keyboard shortcut for Shape=>Selected=>Colour is Ctrl C. 

Flip turns the polygon over so that it is only visible from the other 
side. The polygon is then deselected. 

The keyboard shortcut for Shape=>Selected=>Flip is Ctrl F ' 
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ruse 
Save 
Selected 

~) 

¢ 
~~~~~~...,.....M--~~~~~~~--

'\I w Sha e In ut 
Edit 

New plane creates a new working plane for point entry. Bring up 
the 'Enter new plane' window by following Edit=>New Plane=> and 
then enter the distance from the 0.000 plane that you want the 
new plane to be created at. The units are M and 1 /8 M so to enter 
a new plane 1.5M from the 0.000 plane you enter 1 in the M box 
and 4 in the 1 /8 M box. 

Save ¢ 1-------Selected ¢ Edit 
~r-----.......... --___,J--c~~~-

Edit '\I o Level 
Shape ¢ Hear->Mid 

~-
Wirefra~e ¢ Mid-)Far 
Grid ¢ Far->Mid 
Uiew Mid->Hear 

.J Toolbox 

Copy level copies the entire contents of one level of the shape 
(points and polygons) to another level. The editor is then set to 
that level. If a polygon is selected it is deselected. 
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Shape 
Misc ¢ 
Save 9 

Edit 9 £3 Shape Input 
ermmr>r--...-~ ¢Enter Threshold 
Wirefraflle 9 Distant Colour¢ I 200~ IM 
Grid 9 
Uiew 
Toolbox 

Threshold is the distance in M at which the shape becomes 
visible in the world. Beyond threshold the shape is invisible. 
Between the shape threshold and the Distant to Far transition the 
shape is drawn as a single pixel. The colour of that pixel is set 
from the Distance colour menu item. 

Shape ¢ Wirefraflle 
Im I~ I E!~!I r> Axis views 
Grid ¢ 3D view 
Uiew 
Toolbox ' 

Axis views opens a window which shows the complete shape in 2 
dimensional wireframe from a selection of viewpoints. 3D view 
opens a window which shows a 3D wireframe which can be 
rotated and scaled. See the Wireframe section for more details. 
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Colour 

Shows the colour of the current polygon in hex (00-ff). Clicking on 
the colour icon opens the colour picker (see earlier). 

Tools 

Tools Clicking on Tools extends the 
toolbox window to reveal these 

I Select group Rotation functions. If Select group is 16 (L lei I selected then the tools o~erate 
Scale T 1 t. on a selected group of points. If rans a ion s 

1 
. 

1 I' . -- p~ _ I' .z1r:1.z1 ILIQILI e ect group 1s not se ected then 
. 1.::2 i.::::._ i.::::._ L:::'..X _.... ~ _.... the tools operate on the whole 

shape (all levels),. 

Select group enables you to select a number of points with the 
right mouse button and then perform the translate, Rotate & Scale 
functions on them. Clicking with left button starts a selected 
group, right button adds (or deletes) from the group. The selected 
group is shown in all wireframe views and the main window. 

Translate 
Rotate 
Scale 

Each tool has three icons to represent its operation along/around 
the X,Y and Z axis respectively. The Scale tool also has a fourth 
scale in all directions at once icon. 

To operate a tool click on the required icon and an input box will 
popup, enter the required values and click on OK to perform the 
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operation. 

For example to move the whole shape by 5 M: Click on Tranlate 
in Y (middle icon), type 5 into the M box and click on OK. The 
shape will now be moved +5 M in the Y direction (up). 

' 
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Wireframe 

The Axis views window shows views of the shape from the X Y Z 
viewpoints (top to bottom). It can be zoomed independently with its 
own window menu. 

Wirefraflle 

1:1 ~ 
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30 view gives a window that shows a 30 wireframe view which 
can be scaled and rotated independently by it's own window 
menu. 

I (3 3D Wirefraflle 

~I Rotate & Scale 
X +l[]J[± Scale 
y +l[]J[± r+ 1 I 1 r+ 
z +l[]J[± r+ I r+ 
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View 

The view program shows the shape as it will be seen in the 
simulation. You can rotate and zoom the shape with the mouse 
and its buttons. 

Move mouse left/right -
Move mouse up/down -
Left mouse button 
Right mouse button 

rotate shape about Y axis. 
rotate shape about X axis. 
move towards shape. 
move away from shape. 

The view program shows the distance to the shape in M at the top 
left of the screen and the detail level of the shape (1-near, 2-mid, 
3 - far) at the top right. Keys 1, 2, & 3 on the main keyboard allow 
you to view each level independently to distance. 

To exit back to the desktop press Esc. 
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!World FST 

World is a simulation object database editor. You can use it to 
create and edit simulated worlds. 

World is controlled from a menu tree (for a description of menus 
see the Acorn User Guide Part 1) and a set of windows. 

Starting World 

World is started the same way as other editors: by first installing its 
icon on the icon bar and then clicking on that icon. For more 
details see Acorn's User Guide Documents and their editors. 

Icon bar menu: 

Norld About this progra"' 
i .. u:1•¢' Ha"'e: Ground 
Quit Purpose: Ground Editor 

Author: © Si"'is Ltd, 1998 
Uersion: 1.88 ' 

Info tells you about World. 

Quit removes the World application from the icon bar. If unsaved 
data exists in the world database a warning box is displayed 
asking you to SAVE, DISCARD, or CANCEL. 
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The World Window 

To open the World Window click on the icon bar icon with the left 
button. The world window shows database objects and routes and 
allows you to create new objects, move them and alter their 
behaviour. The World window represent 100 sq km of simulated 
world database. 

Basic Ideas 

Objects 

The world is built up from objects. There are a number of different 
classes of objects available; these are listed below: 

Scenery 
Depot 
Hanger 
AA Gun 
SAM 
Beacon 
Player 

All objects have some things in common. Every object has a 
position in the world, a shape name defining its appearance in the 
simulation, an orientation in the world and some flags defining it's 
basic behaviour. In addition there are class attributes for every 
object, the exact range depends on the object class. 

The 'Player' object is a special case, it is automatically created and 
cannot be deleted, it represents the player in the simulated world 
and its position, shape and class attributes define where the 
simulation starts and how the player's aircraft behaves in it. 
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Routes 

Routes are used to link objects in the world together. Specifically 
routes run from depot class objects to any other object. The 
behaviour of a depot in the simulated world is to supply ground 
vehicles to the world at intervals. These vehicles follow routes until 
they reach their destinations (any object), the behaviour of the 
vehicle upon reaching it's destination depends upon the class and 
state of the destination object. 

World 'modes' 

You use World in three operating modes 

o Object mode is used to create, move and modify objects. 
o Route mode is used to create and modify routes. 
o Route Enter mode is a special mode used when entering a 

route. 

Object and Route modes are chosen from the menu or toolbox. 
Route enter mode is entered via Object mode: 
(World=>Object=>Add route). 

' To add a new object to the world -

Drag a shape file from a directory viewer onto the world window. 
An object with the selected shape will be created at the point 
where the drag ended. The object will be of scenery class as 
default. 

49 



FLIGHT SIM TOOLKIT 

World menus: 

World Misc 
Draw routes 

Save Draw all 
y1 Object Ground colour ¢ 

Route Sky colour ¢ 

Zoo"' Weather ¢ 
Grid Read detail ¢ 
Toolbox Si"'ulation load abs 

Draw Routes on/off: when on routes are drawn on the world 
window in all modes, when off (default) routes are only drawn in 
the 'route' modes. 

Draw All on/off: when on all objects are drawn in detail, when off 
(default) only the selected object is drawn in detail, the remainder 
of the objects are drawn as boxes bounding the maximum size of 
the object. 

Ground colour - colour selector (default green) used to set the 
basic ground colour. Sky colour - colour selector (default blue) 
used to set the sky colour. 

Weather 
Wind speed 
Wind direction 

These menu items allow you to set the basic weather parameters. 
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Read Detail controls how the world editor loads and displays 
shapes. When a shape is dragged onto the world window to 
create a new object the Shape file is opened and read to 
determine how the shape should appear in the world window. By 
default the Mid detail plan view of the shape is loaded for display. 
This can be altered via this menu option, the more detail loaded 
the more information will be displayed in the world window, 
however the trade off is the redraw speed of the objects in the 
window. 

Simulation load abs: is short for simulation load absolute 
filenames. The default is OFF which means that data files (world, 
Model, Shape, Cockpit) will be loaded by the simulation from 
positions relative to the simulation 'Fly'. ie. the world database file 
'World' is in the same directory as Fly & !Run, all the Shape files 
referenced are in a directory called Shape and the rest of the data 
files are in a directory called Data (all on the same level). If the 
Abs option is selected then Shape, Model, Cockpit & Sprite fil~s 
are loaded using full filenames, this means that they do not need 
to follow the prescribed project structure. ie you can share the 
data files between projects. NB this function is only useful if you 
have a hard disc or are on a network. 
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World-
Misc ¢ Save as: 
elm¢ 

~ .J Object ~> 
Route :1 world I[!!] Zoo"' 
- .. 

The Save menu allows you to save the database. The save 
procedure is described in full in the Loading and Saving chapter of 
the Acorn User Guide. In order to save a file in the easiest way, 
you need to have on the screen the directory display for the 
directory where you want to save the file. Move to Save, and a box 
appears, containing an icon, the current filename and an OK box. 
If the file has not been saved before, World offers you a default 
filename of 'world'. If you want a different name then delete World 
and type in the name you want. Place the pointer on the icon in 
the menu and drag the icon into the destination directory display. 
If the file has been saved before then the full pathname will be 
displayed in the filename box, to save the file click on the OK box. 

World=>Object 

Clicking on World=>Object sets the editor into Object mode, the 
Object item will be ticked in the menu when in Object mode. In 
Object mode clicking on the world window with the left button will 
select the nearest object. The selected object will be hilighted and 
displayed in detail. The object may be moved by draging it with the 
adjust (right mouse) button. 

The World=>Object submenu has selectable entries when an 
object is selected: 
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Norld 
Misc ¢ 

Save ¢ Object 
41!J..Plc'J Attributes - display/modify class behaviour of object 

Route ¢ Class ¢ - set class of object 

Zoo~ ¢ Flags ¢ - general behavior of objects 

Grid ¢ Copy "C - create a copy of the object 

4 Toolbox Delete "X - delete object from the world 

... - if the object is a depot add a new route 

World=>Object=>Attributes 

Selecting this menu item opens the Object Attributes window, the 
class behaviour of the currently selected object is displayed (and 
may be modified) in the window. For more details see the 
attributes section. 

.ttnmnll•c> Attributes Class 
Route ¢ 
Zoo"' 
Grid 
Toolbox 

¢ 
¢ 

Class 
Flags 
Copy 
Delete 

nou fi 

¢.t Scenery 
¢ Depot 

"C Hanger 
"X AAGun 

SAM 
Beacon 

\I I 

Scenery - the object merely exists in the world, it plays no 
part in the simulation. 

Depot - the object supplies trucks in the world at regular 
intervals, it has routes linking it to other objects in 
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AA Gun 
SAM 
Beacon 
Player 
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the world. 
- the object supplies enemy aircraft to the world at 

regular intervals. 
- the object is an anti aircraft gun. 
- the object is a Surface to Air missile launcher. 
- the object is a navigation beacon. 
-you! 

To set the class of an object, select the required menu item in this 
menu. 

Save ¢ Ob"ect 
~Ii] mi431 ¢t--A_t_t_r __ i b ... u_t_e_s _--4 ,___ ___ _, 

Route ¢ Class ¢ Fla s 
t--------4 

ZOOM 
Grid 

~Toolbox 

¢ ¢ Land on 
¢ Copy "C 

Delete "X 

If Land on is set (ticked) then the player may land on the object 
(i.e. a runway or taxiway). If Rebuild is set and the object is the 
destination for a route then when a vehicle reaches the object to 
supply it and the object has been destroyed it will be rebuilt. If the 
flag is not set the object will remain 'dead'. 

World=>Object=>Copy 

Copy the selected object. The copied object will inherit the 
attributes and flags of the original but any associated routes will 
not be copied. The keyboard shortcut for this operation is Ctrl C. 
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World=>Object=>Delete 

Delete deletes the selected object from the world database. If the 
object has routes starting or ending at the object those routes are 
also deleted. The keyboard shortcut for this operation is Ctrl X. 

World=>Object=>Add Route 

Add Route can only be performed from a depot class object. A 
new route starting at the depot object is created, the World editor 
mode is automatically changed to Route Enter. Clicking on the 
world window with the left button enters a turning point on the 
route (or an intermediate destination), clicking on the right button 
links the end of the route to the nearest object. Subsequent 
changes to a route are made in Route mode. (Each route must 
contain at least one intermediate point). 

World=>Route=> 

Clicking on World=>Route sets the editor into Route edit mode, 
the Route item will be ticked in the menu. Route mod~ may also 
be selected from the toolbox. All routes in the world will be 
displayed. 

' To select a route click on it, the selected route will be highlighted 
and it's points shown as small blocks, the point closest to the 
mouse click will be also be selected (shown as a filled block). 
These route points can moved by dragging them using the adjust 
(right) mouse button. 
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The World=>Route submenu has selectable entries when a route 
is selected: 

Object ¢ Route 
Jlm!!lm¢ Insert point 

Zoo fl\ ¢ Set point height ¢ 

Grid ¢ Delete point 
J Toolbox Delete Route "X 

Insert point adds a new point to the selected route, the new point 
is added after the currently selected (filled) point. 

Choosing Set point height opens an input box showing the 
selected point's height in meters (Default 0). This may be 
changed from the input box. Route points will typically want to be 
greater than zero when crossing bridges. 

Delete point deletes the currently selected point, a route must 
contain at least one point so this item has no effect if the select 
route only contains one point. 

Delete route deletes the currently selected route. 

Save ¢ 

Object ¢ 

~Route ¢ 

fnll¢ 
Grid ¢ 

J Toolbox 

Zoon 
In 
Out 

The Zoom menu allows you to zoom in 
(and out) on the world. Zoom in 
magnifies the world by a factor of two 
(Zoom out shrinks it by a factor of two). 
Zoom will zoom in/out around the 
selected object or route, if none is 
selected then the centre of the world is 
used. 
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Zoo fl\ ¢ Grid 
.. ¢ 

J Toolbox --------
10K 
1K 
100M 
12.5M 
1.6M 

J off 

World=> Toolbox 

Lock on/off: when lock is on all objects 
loaded or moved and all route points are 
locked to the current grid. 1OK->1 .6M 
controls the courseness of the grid. 'off' 
turns the grid (and Lock) off. 

The Toolbox window shows general information about the world 
database and allows control over how it is displayed in the World 
window. All toolbox options are available from the world menu 
structure. 

~I[:) I Toolbox 
llllllllll1eeeeel 

Object _ I 
Route ' 

Route Enter 

Grid Lock llili] 
Draw routes o 

Draw all ID 
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Zoom - Clicking with the left button zooms in on the world by a 
factor of two (clicking with the right button zooms out) left button 
zooms in, right button zooms out. The icon to the right of the zoom 
button shows the amount of the world (in M) displayed across the 
window. 

Editor modes 

Object 
Route 
Route enter 

To select the editor mode either click on the mode icon in the 
toolbox window or select the mode from the Mode menu operation 
on the World window menu. Details of the editor modes are 
discussed in the World window section. 

Grid Lock - on/off: controls the position of objects/routes in the 
world at the end of a set or drag operation. If lock is on the object/ 
route is set to the nearest grid point to the mouse, if lock is off the 
the object/route is set to the actual mouse position. 

Draw route - on/off: when on draws routes in Object mode as well 
as Route mode (the default is only to draw routes in the route 
modes). 

Draw all - on/off: when on draws all objects in detail, when off 
(default) only the selected object is drawn in detail, the remainder 
of the objects are drawn as boxes bounding the objects maximum 
size. 

58 

FLIGHT SIM TOOLKIT 

Attributes Window 

This window shows and allows modifiction of the behaviour of 
objects in the world editor. The attributes shown depend upon the 
class of the object, the first five fields are common to all objects: 

Object class is set via the Object=>Class menu options. 

Object Shape is the name of the 3D shape which defines the 
appearance of the object in the world. Object shape is not 
alterable in the attributes window. 

Dead Shape is the name of the 3D shape which defines the 
appearance of the object in the world when it has been destroyed 
in the simulation. It is initialy blank, this indicates no 'dead' shape. 
To set the dead shape, drag the required shape file from a 
directory viewer onto the Dead Shape icon in the attribute window, 
the shape name will appear in the icon. 

Strength can take the following values: 

Transparent 
Fragile 

Weak 

Strong 
lndestructable 

- cannot be hit 
- one cannon hit (or anything else) will destroy the 
o~ect • 

- at least three cannon hits or rockets required to 
destroy the object 

- can only be destroyed by rockets or missiles 
- cannot be destroyed however much you try 

Initial value is set to Weak, to alter field click on icon and value will 
cycle. 
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irJ O Object Attributes 
Object class scenery 

t---------t 

Object Shape untitled 
1---------1 

Dead Shape 
~----~ 

Strength 

c~ I e I Height .__I _e ___, 

Rotation - this is the orientation of the object on the ground in the 
world, it is in degrees (0 - 360). The change rotation click on the 
rotate icon and type the required value into the popup input box. 

Height - the height of the object above the ground in M. 

Class Attributes: 

Scenery 

Depot: 

- none 

Uehicle shape~---.....i1 
Uehicle speed. 8 

--;:===:::: Initial supply 
Rate of supply 
Group interval 
Group size 

. 
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Vehicle shape - this defines the appearance of the vehicles 
produced by the depot in the simulation. To set: drag a shape file 
onto the icon. 

Vehicle speed - this is the top speed of the vehicles supplied by 
the depot (in Knots). To set: click on icon, an input box will popup. 

Initial Supply - this is the number of vehicles in the depot when the 
simulation starts. To set: click on icon, an input box will popup. 

Rate of Supply - this is the interval (in minutes) between the depot 
sending out groups (convoys) of vehicles. To set: click on icon, the 
value will cycle. 

Group interval - this is the time (in secs) between each vehicle in a 
group being despatched form the depot. To set: click on icon, the 
value will cycle 

Group size - this is the size of a group supplied by the depot. 

Hanger 

R1C shape 
RIC "'odel 
Initial supply 
Rate of supply 

e 
' 

Aircraft shape - this is the shape of the aircraft launched from the 
hanger. To set: drag shape file onto icon. 

Aircraft model - this is the aerodynamic model for the aircraft 
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launched from the hanger. The model file also defines the weapon 
load carried by the aircraft). To set: drag model file onto icon. 

Initial supply - this is the number of aircraft in the hanger at the 
start of the simulation. To set: click on icon, an input box will 
popup. 

Rate of supply - this is the interval (in mins) between aircraft being 
launched from the hanger. To set: click on icon, the value will 
cycle. 

AAGun 
SAM 

Beacon 

- none 
- none 

I !dent if icat iol 50 II 

Identification - the VOR beacon identification code. To set click 
on icon, an input box will popup. 

Player 

AtC cockpit~~----
AtC titodel [ 

Aircraft Cockpit- This field sets the cockpit shown in the 
simulation, to set drag cockpit file onto icon. If this field is not set 
the bottom of the screen will be black in the simulation. 

Aircraft Model - this field sets the aircraft model for the player 

. 
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(you!), if you do not set this then you will have a basic model to fly 
with average perfomance. To set: drag model file onto icon. 

' 
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!Cockpit is an editor, it allows you to create and edit aircraft cockpit 
and head up display layouts. 

Starting !Cockpit 

!Cockpit is started in same way as other editors: by first installing 
its icon on the icon bar and then clicking on that icon. For more 
details see Acorn's User Guide "Documents and their editors". 

Icon bar menu: 

Cockpit 
Info ¢ 

Instrufl'ents 
HUD 
Quit 

Info tells you about !Cockpit. 

Instruments and HUD open the respective windows. 

Quit removes the Cockpit application from the icon bar. 

Clicking on the icon bar icon with the left mouse button opens the 
main Cockpit window and the instrument window. 
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The Cockpit window 

This window shows the layout of the head down instruments and 
the cockpit background. 

" (3 Instru111ents 
I RI ti111eter 11 RSI RPM Rtt i tude 11 Co111pass 

I UOR 11 Fuel ROR G 111eter 11 US! 

!Wheel Brake II Gear Radar Rir Brake 1 1 Side SI ip I 
I Low Rlt 11 Stalled Low Fuel Rutostab I 
I Hyd Fa i I 11 Hav Fa i I 1 1 Radar Fa i I HUD Fa i I I 

' 
Setting the cockpit background 

To set the background drag a sprite file onto the window. The 
sprite file must contain only one mode 13 sprite 320 pixels wide 
and 100 pixels high. (See the example in !Flight.data.sprite). The 
sprite must NOT contain a palette or a mask. 
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Adding instruments 

To add a new instrument to the cockpit drag the required 
instrument from the instruments window (with the left mouse 
button) onto the cockpit window, this can be positioned on the 
cockpit with the left button and resized by dragging with the right 
button. The cockpit background sprite must have black areas 
(circles and squares) where the instruments are positioned; if they 
don't the instruments will not be drawn correctly in the flight sim. 

Removing instruments 

To delete an instrument from the cockpit, drag it out of the cockit 
window (with the left button) onto the screen background. 

Window Menu 

Save=> 

Save works in the same manner described in the previous tools. 

Instrument window 

This window shows all the instruments available for creating a 
cockpit. It's use is described in the previous section . 
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HUD window 

The HUD window allows you to control the symbols displayed on 
the HUD. The HUD instruments are in fixed positions, the window 
menu allows you to 'turn on' (or off) and instrument. (If no hud 
symbology is selected no hud will be drawn). 

ir:i 0 Head Up Display 
HUD 

I 12 
J' Heading tape 

06 09 J' UOR direct ion RSI ALT I Airspeed 
o- - / Altitude 

USI J' Pit ch bars 
·l-1 - .I USI • • 

J' AOA 
ROA 

I Ueloci ty Uector 

' 

67 



FLIGHT SIM TOOLKIT 

!Model 

!Model is an editor, it allows you to create and edit aircraft models. 

Starting !Model 

!Model is started in same way as other editors: by first installing its 
icon on the icon bar and then clicking on that icon. For more 
details see Acorn's User Guide "Documents and their editors". 
Icon bar menu: 

Model About this Progra"' 
llillil¢ Ha"'e: I Model I 
Ouit Purpose: I FST Aero Model Editor I 

Author: I © Si"'is Ltd, 1991 I 
Uet'sion: j 1.88 I 

Info tells you about Model. 

Quit removes the Model application from the icon bar. 

The Model window 

The main model window shows a plan and an end on view of an 
aircraft's major flight surfaces. The twelve hilighted points on the 
aircraft can be adjusted by draging them with the left mouse 
button. The effect of dragging a point is to change the shape of the 
flight surface. Each of the points is restricted in movement. The 
red cross in the centre of the plan view is the centre of gravity of 
the aircraft. 
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Model 
Data 
Ordinance 
Save ¢ 
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~ C3 llodel 

Data and ordnance open the corresponding windows. 

Save works in the same manner described in the previous tools. 
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" (3 Rircraf t data 
Wing incidence I 2. 00 

stall I 22 

Engine type 
power I 20000 

Fuel capacity I 10000 
Weight I 30000 
Undercarriage 
U1C Type 
Drag 
Control power 1.50 

This contains general parameters covering 
performance, engine and undercarriage layout. 
To change parameter click on the values boxes. 

Ordnance window 

~IOI Ordinance 
Cannon rounds 250 I 
Rockets 32 I 
Rir - Rir 6 I 
Rir - Ground 2 I 
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This window contains parameters defining the weapons the 
aircraft carries. 

To change parameter click on the values boxes 

• 
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Section 3 

Aircraft Controls 

Flight Controls 

Engine on/off 
Throttle up 
Throttle down 
Full power 
Idle power 
Power 10 - 100% 
Landing gear 
Wheel Brakes 
Air Brakes 
Emergency eject 

Control Device Selection 

Analogue joystick 
Keyboard 
Mouse 
Calibrate joystick 

Keyboard Control 

Roll left 
Roll right 
Pitch up 
Pitch down 
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'E' ,_, 
I I 

Shift'+' 
Shift I I 

1 ,2,- - - 0 
'L' 
'W' 
'B' 
'Ctrl-E' 

'Ctrl-J' 
'Ctrl-K' 
'Ctrl-M' 
'Ctrl-Z' 

.. .. 
.... .. 
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Centre 'PAD O' 
Joystick centre 'Z' 
Pitch trim up 'PAD+' 
Pitch trim down 'PAD-' 
Zero pitch trim 'PAD*' 
Rudder '<' '>' 

Weapon system 

Fire cannon joystick button 1 
mouse button 1 
'Delete' 

Select weapon 'Backspace' 

Select target 'Return' 

Fire weapon joystick button 2 
mouse button 2 
'Space bar' 

Drop flares 'F' 
Drop chaff 'C' 

Avionic systems ' 

Autostab on/off 'A' 
Radar range '/' 
SelectVOR '·' 

' 
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Simulation Controls 

Sounds 

Views 

Engine noise on/off 
All noise on/off 

'N' 
'Q' 

Keys in ()are active when flying from the keyboard 
Forward with intruments PAD 8 (F8) 
Forward without instruments PAD 5 (F5) 
Forward right PAD 9 (F9) 
Right PAD 6 (F6) 
Rear right PAD 3 (F3) 
Rear PAD 2 (F2) 
Rear left PAD 1 (F1) 
Left PAD 4 (F4) 
Forward left PAD 7 (F7) 

Aircraft ouside view 
'Tower' view 
Missile view 

Miscellaneous 

Pause on/off 
Fast time on/off 
Select database exploration 
model 
Real aircraft model 
End simulation 
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'O' 
'M' 

'P' 
'X' 

'Ctrl-B' 
'Ctrl-A' 
'Esc' 

FLIGHT SIM TOOLKIT 

Aircraft Displays 

Head Up Display (HUD) 

The functionality of each of the available HUD features is 
described below: 

Altitude: Vertical height above the ground displayed in feet. 

Airspeed: Shown in Knots (1 Knot:= 1.25 MPH) 

Pitch Bars: The pitch bars stay parallel with the ground at all 
times. You can use them to recover from unusual attitudes and to 
keep your wings level when the horizon is not visible. The lines 
are at 1 O degree intervals with a cross at 90 degrees (the nadir). If 
the cross is in the centre of the HUD then you are either travelling 
straight up or straight down. 

VSI (Verical Speed Indicator): This shows your rate of climb or 
descent. An essential source of information when manoeuvring 
close to the ground. The VSI has two markers, the upper marker 
is the centre point (zero rate of climb), the lower is the maximum 
rate of descent allowed for landing. 

' LFD (Longitudinal Flight Datum): Shows the direction the nose of 
the aircraft is pointing in. 

G: Shows the amount of G that the aircraft is pulling during 
manoeuvres. 

AOA (Angle of Attack): Is the angle between the direction of the 
airflow approaching the aircraft and a line drawn between the 
leading and trailing edges of the wing. The lift generated by the 
wing is dependant on this angle. Too high and the wing stalls, lift is 
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dramatically reduced and the aircraft may become uncontrollable . 
Conventional wings stall at less than 20 degrees of AOA. 

Velocity Vector: Gives an indication of the true direction that the 
aircraft is flying in. 

Heading: A tape indication across the top of the HUD and shows 
the current heading in tens of degrees. 00 is north, ~ is east, 27 
is west and 18 is south. 

Beacon: Direction to next nav. point is shown in the HUD by a 
red marker in the heading tape. You fly towards a or beacon by 
aligning the marker with the central tick. 

Weapon: Shows the weapon you have selected (AA, AG, R) 

Radar 

The Radar display covers a 90 degree forward cone with a 
maximum range of 30 miles. The radar range is selectable from 
30miles, 15 miles and 7 miles. The range is shown at the bottom 
left of the display. 

Indicators and warning lamps 

Landing Gear: Indicates whether the Landing gear of the aircraft 
is locked up (red) or down (green). 

Wheelbrakes: Show when the wheel brakes are selected on or 
off. 

Airbrake: Indicates the position of the airbrake. 
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Autostab: Indicates whether the autostab is on or off. 

Low Alt.: Low Altitude warning lamp. 

Stall: Stall warning lamp. 

Low fuel: Fuel warning lamp. 

Hydraulic fail: Hydraulic failure lamp. 

Nav fail: Navigation system failure lamp. 

Radar fail: Radar system failure lamp. 

HUD fail: Head Up Display System failure lamp. 

Flight Instruments 

Altitude: Vertical height above the ground shown in feet. One 
revolution of the needle is 1 OOOft, thousands of feet are shown as 
digits in the centre of the dial. 

Airspeed: Shown in knots (1 knot = 1.25MPH) • 

Attitude Indicator: This shows your roll and pitch relative to the 
horizon. The blue half is up and the green half is down. The 
attitude ball is useful for aircraft designs that do not have a HUD or 
for when the HUD has failed. 

VSI (Vertical Speed Indicator) : This shows the rate of climb or 
descent. 

AOA: Shows the angle of attack of the wing to the airflow. 
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G: Indicates the amount of G that the aircraft is pulling. 

Sideslip Indicator: Sideslip is when the aircraft is skidding 
sideways in the air. The sideslip indicator is useful when 
performing coordinated turns using the rudder to reduce the 
effects of sideslip. If the indicator reads to the left, you are slipping 
left and should bank less or use left rudder to coordinate your turn. 

Compass: This is a magnetic compass which can be used as a 
main or reversionary instrument. 

Engine Instruments 

RPM: Shows your engine revs. 

Fuel: Shows the amount of fuel you have remaining. 
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yboard Shortcuts: 

• hape 

I lete point Ctrl X 

elete polygon Ctrl X 

elect colour Ctrl C 

I lip polygon Ctrl F 

!World 

,opy object Ctrl C 

I olete object Ctrl X 

Delete route Ctrl X 
• 
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ndex Analogue joystick 70 Fragile 57 
Anti-aircraft 21 Frame speed 16 

3oot 29 AOA 73, 75 > lla folder 28 FSTerr 11, 29 

:;ockpit 4 Attitude Indicator 75 ) d Shape 57 Fuel 76 

:light 9,4,28 Attributes 51 > lete 33,35,53 G 

v1odel 12,21,4,66 Autostab 71, 75 lete point 31,54 

~un 28 Avionic 71 lete route 54 G 76,73 

3hape 12,30,4 Axis views 37,42 pot 21, 46-47, 51, 58 Graph paper 13 

3prites 29 pots 20,3 Grid Lock 39,56 

3ysmerge 4 B lstance colour 37 Ground colour 48 

3ystem 4 I tant 37 Group interval 59 

/iew 4 Backup 3 48,56 Group size 59 

IVorld 4 Beacon 46,52,60 56 

6 colour 35 Beacon: 74 >r w Routes 48 H 

56 colours 35 Beacons 19 

D shape 38 Bridges 54 Hanger 19,21,46,52,59 

D shapes 30 c 
Hangers 3 

Dview 37,43 I rnergency eject 70 Head Up Display 73 
I 11 my 19-21 Heading 74 

Calibrate joystick 70 I ngine 70 Height 58 
Chaff 71 I nter new plane 36 HUD 62,65 

A Gun 19 Clear 32 I nter point 31,33 HUD fail 75 

A Gun 46,52,60 Cockpit 11, 62-63 I nter polygon 31,34 Hydraulic fail 75 

bort polygon 34 Cockpit Editor 7 I c 72 ' 
dd Route 53 Colour 35 I c. 44 

ir Brakes 70 Colour picker 35 

irbrake · 74 Combat 19,3 Identification 60 

ircraft Cockpit 60 Compass 76 I ndestructable 57 

ircraft model 59-60 Coordinate 12 16 Info 30,45,62 

ircraft shape 59 Copy 52 1r 37,39 Initial Supply 59-60 

irspeed 75 Copy level 36 I Ir c 71 Insert point 54 

irspeed: 73 Cursor keys 34,39 I I tros 71 Instruments 62 

ltitude 75 11, 15,35 K 

ltitude: 73 1 ly 10,28 
• 
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<eyboard 70 p Translate 40 
Panel 11 Transparent 57 
Pause 72 19, 21, 46, 52, Truck 20 
Pitch Bars: 73 Trucks 20 

_and on 52 Plane 14 32,50,64,67 
_and-on 18 Planes 34 . 40 u 
_anding gear 70, 74 Player 21,46,52,60 46,51,58 
_FD 73 Polygon 14-15 ea 17 Up/down icons 34,39 
_ock 38,55 elect 71 
_ow Alt. 75 Q Select group 40,31 v 
_ow fuel 75 elect point 33 

Quit 30,45,62 elect polygon 31 Vehicle shape 59 
VI et point height 54 Vehicle speed 59 

R hape 12, 14-15, 31 Velocity Vector 74 
Vlid 39 hape Editor 7, 15-16 Vertices 12 

Vlodel Editor 7 Radar 71, 74 hape window 30 View 15-16, 38, 44 

Vlouse 70 Radar fail 75 hapes 10,3 Viewer 38 
\/love a point 33 Rate of Supply 59-60 hapes folder 28 Views 72 

Read Detail 49 ldeslip Indicator 76 VOR 19, 71 

\I Rebuild 52 imulation 3 VSI 73, 75 
Rivers 16, 18 imulation load abs 49 

\lav fail 75 Roads 16, 18 Sounds 11, 72, 29 w 
\lavigation 19 Rotate 38,40 Stall 75 

\I ear 16,39 Rotation 58 Start-point 18 Weak 57 
New plane 36 Route 21,47,53,56 Strength 57 Weapon 74 

Route Enter 47,56 Strong 57 Weather 48 

0 Route mode 56 Sys Merge 4 Wheel Brakes 70 
Routes 47,3 Wheel brakes 74 

Object 47,50,56 RPM 76 Wireframe 15, 42-43 

Object Attributes 51 Runway 17 World 7,11,13,17-

Object class 57 I hreshold 37 18, 45, 47, 3, 

Object Shape 57 I hrottle 70 28 

Orientation 14 toolbox 33,55 World Editor 7 

Origin 12 lools 9 World Window 46 
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YZ 39 

:>Om 38-39, 42, 54, 56 
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